
Brainstorming with  

MindManager® and allCLEAR® 
ABSTRACT: Most lawyers are familiar with Text-processing tools (like Word and 
Wordperfect), search engines (like LexisNexis, Westlaw and Loislaw) and litigation 
support databases.  However, few have worked with true brainstorming tools that assist a 
lawyer in reaching conclusions and identifying connections between information. Two 
tools that should be part of the "thinking lawyer's arsenal" are MindManager® from 
Mindjet  (www.mindjet.com) and allCLEAR® from Proquis (www.proquis.com). 
MindManager creates idea maps that let you link issues, facts, documents, and solutions 
in a multi-branching tree.  allCLEAR's FlowCharter and Analyzer builds process 
diagrams and lets you evaluate multiple paths in the process to determine which path is 
optimal. On a scale of one to five, I would give MindManager a 5 and allCLEAR a 4.5.   

A LAWYER PROGRAMMER LOOKING FOR NEW TOOLS 

As many of you know, I am a "recovered" lawyer.  I am "recovered" from the approach 
to the legal business that views profit in terms of maximizing the number of hours that 
can be charged to a client.  As a legal technology consultant who designs and implements 
time-saving solutions for law firms, I have searched for brainstorming tools to help me in 
my work and to offer to my clients.   

Over the past few months, I have evaluated two innovative tools: MindManager® from 
Mindjet  (www.mindjet.com) and allCLEAR® from Proquis (www.proquis.com).  They 
are innovative in that they branching trees, webs and flow diagram to represent complex 
information visually.  Much as the brain provides links between information, these 
programs allow the user to visually represent (and follow) those links to both better 
organize information and to reach conclusions.  In my work, we use these programs to 
design document assembly systems that produce dozens of documents form a single core 
interview.  We also use these programs to develop and present web-seminars, in the same 
way one might use PowerPoint, to visually represent the topics to be discussed in a 
lecture. 

MindManager creates idea maps that let you link issues, facts, documents, and solutions 
in a multi-branching tree. The resulting outline can then be integrated into Microsoft 
Office, tied to events and tasks in outlook, documents in Word, charts in Excel, and web 
pages.  Mindmaps can be exported to PowerPoint and Word, where they can be edited.  
And dynamic maps can be posted to a website.  A single-user license for MindManager 
Basic 6 costs $229. For tighter integration with Outlook and Microsoft Office, your 
should  consider  MindManager  Pro  6  which  costs  $349.  There  is  also  Mac  version,  
MindManager 6 Mac which costs $229.  A free 30-day trial is available for download. 

allCLEAR's FlowCharter and Analyzer build process diagrams and lets you evaluate 
multiple paths in the process to determine which path is optimal.  The FlowCharter builds 
tree diagrams and organization charts from a simple text editor in minutes, and then lets 
you refine these charts with powerful graphic tools to get the precise look you need.  



Analyzer,  lets  you  then  add  data  to  each  of  the  steps  and  branches  in  the  chart  for  the  
purpose of finding all the paths through the process, and lets you calculate totals, 
averages, and probabilities.  FlowCharter is $315 for a PC License and $457 for a each 
concurrent network license.  Analyzer (which includes FlowCharter) is $778 for a PC 
license and $1,094 for each concurrent network license.  A free 30-day trial is also 
available for download. 

For this review, I have received free copies of the software and attended web demos.  I 
have no current relationship or affiliation with either vendor.  The two programs are 
complementary, rather than competitive; each addresses a different aspect of 
brainstorming, though there are some feature overlaps.  I tested the software on a Pentium 
IV, 2.4 GHz desktop, with 2 GB RAM, running Microsoft Windows XP and Microsoft 
Office 2003.  There was more than enough power to run both programs.  There are some 
special features of MindManager for Office 2007 that I was, unfortunately, unable to test.   

IDEA MAPS with MINDMANAGER 

In a typical litigation, a lawyer must sift through millions of bits of information, and 
extract from that information a "story".  This is the "story" that will be presented through 
documents, demonstrative exhibits, depositions and live witness testimony to a judge and 
jury.  The  source  information  may  be  locked  in  documents,  transcripts,  legal  memos  
found on a file-server, a web server or locked in various databases. 

The current approach is to write memos on various topics in the litigation.  And for each 
topic, conduct searches to find supporting information.  Each memo "stands alone".  As 
facts change, the memo may or may not be redrafted to reflect the new facts.  Over a long 
litigation, there may be hundreds of memos to file. 

Picture instead a single file (an idea map) that organizes all the theories of the case and 
includes hyperlinks to all the supporting documents and data sources.  This idea map 
could include links to other idea maps.  Rather than being a monstrous memo, the map 
visually represents all the theories of the case, and all the supporting evidence in a 
branching tree. Using a simple plus (+) and minus (-) you can expand and collapse each 
branch of the tree.  You can reorder the branches in a priority.  You can even assign tasks 
(and schedule them) to different branches. 

MAPPING THE BRAIN WITHOUT A CAT SCAN 

With MindManager you can brainstorm faster and more accurately because you can see 
both the forest, trees and grass through a single interface; send that information to 
PowerPoint or Word, and roundtrip it.  Whether a lawyer is preparing for trial or deciding 
on a strategy for a complex negotiation, MindManager can map the roots and branches to 
an effective argument. 

You start MindManager by choosing a template.  The template sets the basic look of your 
map.  Some prefer a "spider web" with spokes heading out from a central topic.  Others 
prefer a fishbone: with branching topics descending left and right from an initial topic in 



the head. I prefer an elbow diagram, with subtopics branching out in a vertical list from 
an initial topic. 

Once you choose a template, you can just type.  When you use the enter key, it creates a 
new topic.  When you use the insert key, it creates a subtopic.  If you don't like the order 
of your topics, you can use the mouse to drag the topic (and all the subtopics under it) to 
a different location in the map.   

Using MindManager, I prepared the bullet points for a one-hour lecture in 15 minutes, 
including several changes in the structure of the lecture as I thought through what I 
wanted to say. MindManager also has a "presentation mode" that can be used in place of 
PowerPoint. 

 

MindManager can export a map to Word as an outline (using Heading and numbering 
styles).   It  can  also  be  used  to  export  to  PowerPoint.   If  your  firm  has  a  particular  
PowerPoint  template,  you  can  have  a  complete  PowerPoint  slide  show  with  bullets,  
animation, links and speaker notes in a matter of minutes.  

The uses of MindManager are limited only by your imagination. A litigator might use 
MindManager to map out the evidence supporting a particular theory of the case.  Each 
branch  of  the  tree  could  represent  a  particular  fact.   And  for  each  fact,  there  could  be  
links to supporting documents, pictures, testimony excerpts, and legal research.  Taking it 
one step further, you could use that program to map to prepare a deposition outline.  You 
could layout the topics to be covered.  Under each topic, you could identify the line of 
questions. And with respect to each question, you could have links to the documents, 
images, or excerpts you wish to present to the deposition witness during that particular 
question. 



While you could export the map to Word and print it out, you might consider using 
MindManager live during the deposition.  You could use the "links" to launch an 
graphics for use in the deposition.  For each topic, you could assign a "status" to indicate 
how well the topic was answered by the deponent.  You could reorder who lines of 
questions with a click.; and you can summarize the deponent's response as notes on each 
question topic.  

With it’s close links to Microsoft Office, MindManager can also serve as a project-
manager.  When a single click you can convert a topic on a map into an Outlook task and 
assign it to one of your legal team.  That said, MindManager is one of the few programs I 
know of that is truly "cross-platform". Create a map on a P.C., and then open it on a Mac 
– no conversion required. 

For teams that are distributed across multiple offices, you can send your MindMap with a 
free viewer.  Better yet, you can post the map to a web-server.  With a few lines of code 
on a webpage, you can make your map available for anyone visiting your website.  

SOME MINOR RESERVATIONS 

Sometimes you find a tool for which you have very little critical to say.  MindManager 
has a very slick interface.  They have tightly integrated their software with Microsoft 
Office, including special integration into Office 2007 that lets you design a map in 
MindManager, export it to Word for further editing, and then reimport it back into 
MindManager with full integrity.  MindManager uses the WordML format to store 
information about the map which is not otherwise editable in Word.  

That said, I have a few pet peeves. The export to PowerPoint is very effective.  However, 
it  presumes  that  "notes"  are  meant  to  be  "speaker  notes"  rather  than  text  that  follows  a  
bullet.  It would be helpful to have an option to allows the notes to appear in the 
PowerPoint presentation as text following the bulleted topics. 

The export to Word could also be a little more intuitive. Unless you have modified the 
default Heading 1, Heading 2 and Heading 3 styles in Normal.dot, the export will require 
extensive reformatting in Word. A few more export options in MindManager might allow 
you to achieve the exact formatting without having to make style changes in Word.  This 
would also have the added benefit, if and when, you decided to bring the Word outline 
back into MindManager. 

Rating: On a scale of 1 to 5, I would give MindManager a 5. 

FLOW CHARTS and PROCESS DIAGRAMS with allCLEAR 

I used to view process maps and flowcharts as the domain of high-end programmers and 
engineers.  These charts, replete with symbols, funny shaped boxes, arrows and colors 
reminded me of the schematic diagrams of the circuit board of an old stereo.   



Over the years I have played with organizational chart software programs, but found 
them of limited use in my law practice.  I have dabbled with Microsoft Visio more 
recently, but found the templates very confusing and way too technical:  

 Which box icons do I choose?  
 How do I do branching logic?  
 Why do I need this stuff? 

 

In building automation systems for my clients: whether they be HotDocs templates or 
Time  Matters  chains,  I  was  forced  to  model  "manual  processes"  with  software.   The  
simpler processes, I could describe in a few sentences or keep in my head.  But for the 
more  complex  processes,  I  needed  a  way  to  visually  represent  each  of  the  steps  in  the  
process and get my clients to approve those process before they invested in expensive 
programming time. 

THE TOOL OF CHOICE 

allCLEAR FlowCharter was recommended by my fellow consultant, Wells Anderson 
(www.activepractice.com).  By using a simple text editor, a user can diagram a complex 
process in minutes; allCLEAR handles all the graphics.  By using a simple syntax of 
periods, colons, question marks, parentheses and square brackets, the system will 
automatically build the Flow Chart. 

Take a client intake process.  I have written the steps below, using basic punctuation and 
tabs, and pasted it into allCLEAR's text editor. 

CLIENT INTAKE PROCESS 
 
Cold Call: 
 (Answers) Sales Pitch. 
 (No Answer) Redial. 
 (Machine) Leave Message. 
 Followup Call. 
Engagement Letter? 
  (Yes)Schedule Meeting. 
  Open new matter file. 
  Assign Paralegal 
  (No)Close Prospect 
 
Without any further work, I have an instant FlowChart. 
 



 
 
A picture is worth a thousand words.  The picture above shows the viewer exactly what 
happens, and when.  It works far better than a complex procedure manual (that noone 
reads anyway).   

This is only the beginning of what allCLEAR can do.  The system has a complete set of 
graphics tools. And these tools work in a way that makes sense.  Right click on 
"Engagement Letter?" in the chart above and choose "Cluster Layout".  You can change 
the  structure  to  move  the  "No"  answers  to  the  side,  and  make  the  process  a  more  clear  
vertical flow.  

allCLEAR adds another layer to this graphics tools – the ability to add real data and 
analyze the process to determine the best outcome. Typically, this is done with two 
programs: one handling the graphics, and another which assigns probabilities and weights 
to each step, and calculating a probability of success and the cost of success.   

By changing from text-view to data-view, you can get a list of all boxes in the flowchart.  
Using a spreadsheet, you can add additional fields to each box.  You can, for example, 
add the "time" it takes to perform each task, the "cost" for each task, and any other factor 
you might wish to evaluate. 

Once the data is entered, switch to an analyzer view.  A range of options are only a few 
clicks  away.  The  analyzer,  lets  you  generate  all  the  paths  through  the  process  and  run  



simulations.  There is a "play" button that play a designated path (to illustrate a point) or 
to play all paths to visually represent all the options. 

Choose Tools -> Analyzer -> Probability and click on an branching decision point.  You 
can assign a probability for each choice.  Then you can run simulations, applying those 
probabilities and get the average cost, and average time for all the different paths.   

If  you are a litigator,  wanted to evaluate the potential  outcome of a litigation, factoring 
dozens of different probabilities, this may be the tool you have been waiting for. Also, if 
you just want a way to visually illustrate different conclusions from the same facts in 
trying to build the "story" of the case, allCLEAR is a great brainstorming tool 

A FEW RESERVATIONS 

While allCLEAR is an extremely powerful and well-designed program, it seems dated.  
The icons, colors and graphics seem circa Windows 2000.  They don't have the 
WindowsXP 3-D sculpted look, let alone the transparency for Windows Vista or the 
dynamic ribbon toolbars found in Office 2007. 

With ten different toolbars, it can be confusing where to find a particular task. When the 
program begins, all toolbars are visible, but many are grayed out as inactive.  Many 
toolbars and many items are only functional in certain contexts. One of the most powerful 
tools in the system is a button called "Artist".  The icon looks like something a child 
could draw.  However, the effect on the process map is nothing short of stunning; by 
choosing a particular artistic vision, the entire layout of the process map is altered.  

Further, the program falls short on a number of keyboard-friendly conventions found in 
other programs.  First, a number of functions appear to only be available through toolbar 
icons. For example, I could not access the "Artist" function from the Format -> Diagram 
menu.  Second, the structure of the menus and toolbars should be consistent. For instance, 
the Format -> Drawing menu should match the Drawing toolbar in options.  Third, while 
the program uses menu-accelerators, there are very few short-cut keys for commonly 
used actions. 

WISH LIST for ALLCLEAR 

Within a short time (either by reading the quick start guide or exploring) you will find 
your way around the program.  Any questions can be answered with a search on an 
extensive set of user forums.  allCLEAR is truly easy to use.  My wish is only that a little 
extra time could be put into some of these aesthetic and usability issues. 

A further wish is to build integration with Microsoft Visio.  Some users have asked for 
the ability to export the allCLEAR diagram format (.acd) to Visio.  Given the power of 
allCLEAR to build consistent and highly customized diagrams, I don't see this as a high 
priority.  However, that same understanding could also be used to import Visio diagrams 
into  allCLEAR.  Once  in  allCLEAR  they  can  be  more  easily  manipulated  with  the  
FlowCharter, and then dramatically enhanced with the Analyzer. 



Rating: On a scale of 1 to 5,  I  would give allCLEAR 4.5.   It  is  an extremely powerful 
program, but has a little further to go on aesthetics and ease of use. 
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